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ANEXO I. MOLDFLOW

Autodesk Moldflow es un programa del tipo CAE disefiado para realizar la simulacién de
diversas técnicas de inyeccidén, pudiendo asi evaluar aspectos fundamentales del
proceso de moldeo. Esto resulta muy ventajoso en el proceso de disefio de moldes ya
que reduce lo que posiblemente serian numerosas pruebas de ensayo y error en
maquina, necesarias para la obtencién de la configuracion éptima del proceso de
moldeo.

El programa en cuestion sera utilizado durante este trabajo para la realizacion del
analisis reoldgico de la pieza, con el objetivo de obtener la informacion relativa a la
orientacion de la fibra en el material. Dicha informacion sera transferida, a través del
programa DIGIMAT, a la malla de ABAQUS donde estudiaremos finalmente la pieza con
todas las cargas que le son aplicadas y toda la informacién del material ya
particularizado.

MOLDFLOW nos ofrece un conjunto de opciones para modelar la pieza de estudio
geométricamente. Sin embargo, estas herramientas de dibujo resultan insuficientes
cuando la ésta es compleja. Es por ello que resulta adecuado el utilizar un software de
dibujo 3D como ABAQUS para crear la geometria y posteriormente exportarlo a
MOLDFLOW con formato .stl o .stp.

Procedimiento

Lo primero que tenemos que hacer al abrir el programa es crear un nuevo proyecto (File
-> New Project) e importar el modelo de la pieza obtenido previamente con ABAQUS.
Para ello pinchamos en Import y seleccionamos el fichero en cuestion.

Previo a la simulacién de la inyeccidn de una pieza, es necesaria la representacion de
ésta en elementos que permitan el analisis numérico de su proceso de moldeo. El
método de los elementos finitos, es una de las técnicas que permiten el desarrollo de
dicha discretizacion, resultando en lo se conoce como el mallado de la pieza. Diversos
tipos de malla permiten la representacién de una pieza, sin embargo el software de
simulacién Moldflow solo soporta tres tipos de mallado: el plano medio (midplane), el
cascarén (Dual Domain) y el 3D; las dos primeras, formadas por elementos triangulares
unidos por nodos, mientras la ultima, por elementos tetragonales unidos por nodos. La
seleccion del mas adecuado dependera principalmente de factores como el espesor de
la pieza y su complejidad geométrica, de las capacidades de cdmputo de los equipos de
simulacion, del tipo de analisis a realizar, de los resultados disponibles y de interés para
cada malla, y de la técnica de inyeccidn evaluada. Para la pieza a la que le vamos a
realizar el estudio elegiremos un mallado 3D.

Para terminar con el mallado sélo tenemos que pinchar en la opcién Mesh -> Generate
Mesh y fijar un determinado tamafio de malla. En nuestro caso ese tamafio es de



1.43mm, lo que provoca que nuestra malla esté dividida en 637670 elementos. Cada vez
gue queramos cambiar el tamano de nuestra malla debemos asegurarnos de eliminar la
malla anterior teniendo activada la opcién Remesh already meshed parts of the model.

Tras esto deberemos verificar la calidad de la malla. Primero comprobaremos que no
haya ningln elemento que intersecan, ya sea coplanarios o no. Seleccionamos Mesh ->
Mesh Diagnostics -> Overlapping Elements Diagnostic -> Show. En nuestro caso la pieza
no presenta ningun elemento andmalo.

También es fundamental comprobar que el eje Z que define la pieza estd alineado en la
perpendicular de la pantalla. Esto es necesario para que el programa pueda obtener de
forma correcta la fuerza de cierre necesaria utilizada en el molde en la fabricacién de la
pieza. Si la pieza no se encontrase alineada con respecto el eje Z deberiamos pinchar en
la opcion Mesh -> Utilities -> Modeling Rotate, seleccionamos la pieza, el eje sobre el
gue la queremos rotar y el angulo necesario para que quede bien orientada.

Una vez la pieza ha sido mallada correctamente se deben de crear los canales de
alimentacion por donde el material va a ser inyectado. En este trabajo se dan dos
diferentes configuraciones de entrada de material en la pieza. En la primera de ellas el
material es inyectado en el lateral de la pieza directamente por un Unico punto de
inyeccién, sin necesidad de disefiar ningln canal de alimentacién. En la segunda
configuracion el material es introducido a partir de una mazarota principal, por donde
se inyecta éste, que deriva en tres canales frios.

Para la creacidon de estos canales de la segunda configuracién procedemos de la
siguiente manera:

Primero creamos los nodos correspondientes a la entrada de la pieza y el nodo central.
Esto podemos hacerlo con la opcidn Geometry -> Nodes -> Node by Coordinates. El Unico
nodo que nos quedara por crear sera el nodo incial de la mazarota, es decir, por donde
el material es inyectado. Lo hacemos con la opcidn Node by offset, con la que podemos
indicar el desplazamiento a aplicar en el nodo central creado antes. Este desplazamiento
sera la longitud de la mazarota. Ahora sélo nos quedara unir estos nodos con la opcion
Beam, donde tendremos que asignarle a cada canal la propiedad de canal frio e indicar
gue su seccién sera circular, escribiendo su diametro. Una vez acabados todos los
canales deberemos indicar cudl es el punto de inyeccion con la opcidn Set Injection
Locations de la seccion de Study Taks.

Antes de ejecutar el analisis conviene sefialar que en esta pieza no se ha creado sistema
de refrigeracion al ser ésta tan pequefia que no es requerido, pero en otras piezas ahora
seria el turno de modelar el sistema de refrigeracion. Se puede disenar siguiendo las
mismas instrucciones que con los canales de alimentacion pero asegurandonos que las
propiedades son idoneas para el paso de refrigerante y no para la alimentacion de la
pieza. Por ultimo indicariamos, a través de Set Coolant Inlets los puntos de entrada del
refrigerante, debiendo indicar con anterioridad de qué tipo de refrigerante se trata y
otras propiedades como su temperatura.



En resumen, para proceder con el analisis del modelo deberemos introducir una serie
de datos de entrada:

La geometria de la pieza, de los canales de alimentacion y del sistema de
refrigeracidn. La pieza serd importada desde un archivo ya existente, pero tanto
los canales de alimentacion como la refrigeracion debemos de dibujarla nosotros
en el propio programa MOLDFLOW siempre que sea necesario.

El material del que va a estar hecho nuestra pieza, escogido de una amplia base
de datos que posee el propio programa, y diferentes datos de propiedades
correspondientes a este material.

Parametros del proceso tales como temperaturas de inyeccidon y compactacion
(recomendadas para cada material), tiempos (inyeccidn, compactacion,
refrigeracion...), o presiéon de compactacion. MOLDFLOW nos ofrece una serie de
caracteristicas para cada uno de los materiales del catdlogo, lo que nos sirve de
gran ayuda para la eleccién de los diferentes parametros del proceso.

Tras el analisis MOLDFLOW nos da la opcién de poder visualizar una lista de resultados
que pueden agruparse dependiendo de las siguientes caracteristicas:

Resultados relacionados con la factibilidad: este grupo engloba el llenado de Ia
pieza, temperatura en el frente de flujo, la presion de inyeccion, la fuerza de
cierre y la contraccion volumétrica.

Resultados relacionados con el control del proceso: aqui encontramos la
evolucidn de la presidn, temperatura y capa fria a lo largo del tiempo.
Resultados relacionados con la calidad: aquellos defectos como lineas de
soldadura, atrapamientos de aire y rechupes.

Resultados relacionados con el comportamiento mecdanico: veremos en este
grupo la informacion relativa a deformaciones, tensiones residuales, la
orientacion del flujo y la orientacién de la fibra, siendo este ultimo el resultado
mas importante dentro de nuestro estudio.
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Resultados

En esta seccidn del anexo veremos todos los resultados que han sido relevantes en el
estudio un poco mds detenidamente:

e 1PP20

Tiempo de llenado

Como podemos ver en la imagen, la
pieza se llena por completo en unos 2
segundos, como en todos los casos ya
gue es un dato que hemos fijado para
todo el estudio. La linea de colores de
la izquierda y la propia figura nos dan
una idea del llenado de la pieza frente
al tiempo. El instante inicial
corresponderia al color azul e iria
avanzando hasta llegar al color rojo,
gue es donde finaliza el llenado.

Figura Al.1. 1PP20 Llenado
Vemos como el material avanza desde

el punto de inyeccion, recorriendo toda la circunferencia de la pieza, para acabar
juntandose en el extremo opuesto de ésta.

Presion de inyeccion

En la imagen se observa la -
distribucién de la presién de pg*
inyeccién a lo largo de la pieza. I
Esta es mas elevadaenel punto
de inyeccién del material,
llegando hasta casi los 9MPa, y ||
va disminuyendo hasta ser nula I
en el punto donde finaliza el
llenado. Esto es debido a que la
.

presion necesaria para
introducir el material es
ap|icada en el punto de inyeccién. Figura Al.2. 1PP20 Presion de inyeccion

La presion obtenida es baja y no
presenta ningun problema para la pieza.
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Temperatura en el frente de flujo

Figura Al.3. 1PP20 Temperatura en el frente de flujo

Se trata de la variacion de
temperatura en los dos segundos que
dura el tiempo de llenado. Al igual que
instintivamente asociariamos, el color
rojo de la figura significa una mayor
temperatura y el azul la menor. La
temperatura va disminuyendo al igual
gue el llenado debido a que el material
se va enfriando a medida que avanza
por la pieza. La variacion de la
temperatura entre el inicio (2272C) y
en el final del llenado (2302C) es de
39C, lo que significa que estd dentro
del rango permitido para trabajar, que

estaria en unos 82C. El valor de la temperatura sera un dato que dependerd del material,
ya que es una condicion del proceso de inyeccion que hemos tenido que introducir para

cada material.

Fuerza de cierre

En la grafica se observa como va
aumentando la fuerza de cierre con
el paso del tiempo. Este aumento
es progresivo y constante hasta que
el tiempo se acerca al final de
llenado. A partir de ahi la fuerza de
cierre se ve incrementada
considerablemente desde la
tonelada hasta las 2 toneladas. Este
valor es bastante pequefio ya que
las  maquinas  convencionales
pueden alcanzar fuerzas de cierre
hasta 4000 toneladas.
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Figura Al.4 1PP20 Fuerza de cierre
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Atrapamientos de aire

Figura AlL5 Avance del llenado con una entrada

En laimagen superior se muestra el avance de material en distintos instantes de tiempo,
lo cual nos ayuda a entender mejor cdmo es el llenado de la pieza. En la parte inferior
derecha podemos apreciar la fase final del llenado, en la cual no se observan
atrapamientos de aire.

Tensor de fibra

4 En la imagen se aprecia la pieza
pintada de diferentes colores,
dependiendo de la zona de la que se
trate. A la izquierda de esta una
escala de colores, que va de 0 (azul) a
v | 1 (rojo). Cuanto mayor sea la
Ll |  probabilidad de que las fibras estén
s 'y ~alineadas con respecto a la direccién
e . principal, el valor de la orientacion de
= " fibra va a ser mas cercano a 1, con lo
gue en la pieza estara dibujado en un
color rojizo. En este caso la escala nos
indica que el valor minimo esta en
Figura AL6. 1PP20 Orientacién de fibra 0.33 y el maximo en 0.9, aunque como se
aprecia en la figura, la mayoria de la pieza se
encuentra en valores de orientacion de fibra en torno a 0.75, lo que indica que hay una
alta probabilidad de que la fibra se encuentre alineada.




e 1PP50

Tiempo de llenado
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Aungque hayamos cambiado el porcentaje
de fibra en el material, la distribucién del
material en el llenado es el mismo, siendo
éste completo. De ahora en adelante, al ser
el llenado idéntico para esta configuracion,
solamente se mostrard una imagen de este
para cada uno de los casos.

Figura Al.7. 1PP50 Llenado

Presion de inyeccion

W

Aumentar el porcentaje de fibra en el I
material provoca que la presidn de inyeccién
aumente también hasta los 12MPa, frente a

los 9MPa que teniamos con un 20% en fibra. I

Figura Al.8. 1PP50 Presion de inyeccion

Temperatura en el frente de flujo

::::::

Ni la distribucidon ni la variacién de temperatura
apenas se ha visto afectada por el cambio en el
porcentaje de fibra. Ademas los valores de la
temperatura también son iguales.

Figura Al.9. 1PP50 Temperatura en el frente de
flujo
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Fuerza de cierre

La evolucion de la fuerza de cierre es
la misma pero su valor haaumentado

de 2MPa a 3MPa.

Tensor de fibra
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Figura Al.11. 1PP50 Orientacion de fibra

e 1PA20

Tiempo de llenado
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Figura Al.10. 1PP50 Fuerza de cierre

Vemos como la pieza esta en un tono
mas rojizo que en el caso anterior,
acercandose al valor maximo (0.93).
Esto se debe a que a mayor porcentaje
de fibra mayor cantidad de fibras y por
lo tanto mayor también la posibilidad de
gue estas estén alineadas.

Figura Al.12. 1PA20 Llenado



Presion de inyeccion

Vemos como la presidon de inyeccidn es mas alta
utilizando la poliamida que el polipropileno
(14MPa frente a 9MPa) para un mismo
porcentaje de fibra. Esto puede ser debido a que
la poliamida tiene una mayor viscosidad, por lo
gue el material tendra mas resistencia a al
avance al ser inyectado.

Figura Al.13. 1PA20 Presion de inyeccion

Temperatura en el frente de flujo

Figura Al.14. 1PA20 Temperatura en el frente de flujo

La variacién de la temperatura en el frente de flujo aumenta 1°C con respecto al
polipropileno, debido posiblemente a su mayor viscosidad, pero no es un cambio
destacable.

Fuerza de cierre
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Figura Al.15. 1PA20 Fuerza de cierre
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Atrapamientos de aire

Para un mismo llenado, la forma de los atrapamientos de aire sera la misma. En este
caso se hailustrado en el caso del polipropileno con un 20% en fibra.

Tensor de fibra

0130 “ &

Al cambiar el material a la poliamida
hemos aumentado la posibilidad de que
la fibra se encuentre desalineada o
desordenada. En este caso este valor I

01878

seria de en torno a 0.65.

(e

Inm

Figura Al.16. 1PA20 Orientacion de fibra

e 1PA50

Tiempo de llenado

Figura Al.17. 1PA50 Llenado

Presion de inyeccion

Como con el polipropileno, un aumento en el
porcentaje de fibra provoca un incremento de
la presién de inyeccion. Con la poliamida este
incremento es aln mayor ya que alcanza los
24MPa, frente a los 14MPa con 20% fibra.

Figura Al.18. 1PA50 Presion de inyeccion
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Temperatura en el frente de flujo

En este caso el salto térmico ha
aumentado considerablemente, ya que I
en el punto donde la temperatura es
maxima esta es de 2952C y en donde es
minima de 2859C, lo que corresponde a I
una variacion de temperatura de 10°C,
una cifra que estaria cerca de no ser
recomendada para la fabricacion de la I
pieza. El material podria enfriarse en
exceso durante la inyeccidon y provocar la
aparicion de algun defecto.

Figura Al.19. 1PA50 Temperatura en el frente de flujo

Fuerza de cierre
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Figura AL.20. 1PA50 Fuerza de cierre

La fuerza de cierre es visiblemente mas elevada que en todos los casos anteriores ya que
al final del llenado sube de 2MPa hasta los 4,2 MPa.
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Tensor de fibra
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Figura Al.21. 1PA50 Orientacion de fibra

Observamos que la poliamida, de igual forma que el polipropileno, al incrementar su
porcentaje en fibra aumenta la probabilidad de que las fibras se encuentren orientadas
con respecto a su direccién principal.

e 3PP20

Tiempo de llenado

Hemos cambiado la configuracién
del llenado de la pieza. En este caso
el material es introducido por tres
canales de alimentacién por uno de
los extremos, como se puede ver
en la figura. Al entrar por tres
puntos en lugar de uno, el llenado
es mas uniforme ya que el material
avanza simultaneamente,
recorriendo toda la pieza y toda la
parte inferior de la pieza termina
de llenar a la vez.
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Figura A.22. 3PP20 Llenado
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Presion de inyeccion

Los mayores valores de la presion de inyeccidon se encuentran en los canales de
alimentacion, con un maximo de
8MPa. Esto beneficia el proceso ™ |
ya que la pieza no sufre apenas

de fuerza de presiéon de
inyeccion, sino que los canales
son los que aguantan la mayor
parte. En la pieza la presion es
muy baja, llegando a ser nula en
el extremo opuesto al de llenado = ws
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Figura Al.23. 3PP20 Presion de inyeccion

Temperatura en el frente de flujo

Vemos como el cambio en la
configuracion de llenado a una con
tres entradas no causa diferencias
relacionadas con variacion de la
temperatura en el frente de flujo, ya
gue ésta sigue siendo de 3°C, como
en el caso del polipropileno con un
20% fibra.
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Figura Al.24. 3PP20 Temperatura en el frente de flujo
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Fuerza de cierre

La fuerza de cierre en el instante final no
varia apenas al comparar los casos de
unay tres entradas. Lo mas destacable es
el comportamiento de la fuerza de cierre
durante todo el llenado ya que también
aumenta de forma constante, pero en
este caso s valor es mayor desde el inicio.

Atrapamientos de aire
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Figura Al.25. 3PP20 Fuerza de cierre

Figura Al.26. Avance del llenado con tres entradas

Con esta configuracion de llenado no se produce ningln atrapamiento de aire. Esto es
debido a que el llenado se hace de una forma progresiva y el material llega a todo el
radio de la pieza simultdneamente gracias a los tres canales de alimentacion. Asi
evitamos que esas zonas en las que se junta el material al acabar el llenado, como ocurre

con la primera configuracion de llenado.
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Tensor de fibra

Figura Al.27. 3PP20 Orientacion de fibra

e 3PP50

Tiempo de llenado
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Al modificar la configuracién de llenado
el cambio mds significativo se encuentra
en la direccidon que sigue la fibra dentro
del material. Para el modelo de una sola
entrada veiamos como la fibra seguia la
direccion circunferencial en la pieza pero
con 3 entradas de material la fibra sigue
la direccion longitudinal de la pieza. En
cuanto a la probabilidad podriamos
considerar que es similar en ambos
casos.

Figura Al.28. 3PP50 Llenado

Presion de inyeccion

Figura Al.29. 3PP50 Presion de inyeccion

Aumentamos el porcentaje de fibra hasta

50%,

y en consecuencia la presion de

inyeccion aumenta ligeramente, hasta
alcanzar los 10 MPa.
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Temperatura en el frente de flujo

La variacidon de temperatura sigue siendo de
32C, lo que nos indica que sigue sin provocar
variacion alguna el aumento del porcentaje de I
fibra en el salto térmico.

ancorsc

Figura Al.30. 3PP50 Temperatura en el frente de flujo
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Figura Al.31. 3PP50 Fuerza de cierre

También la fuerza de cierre sufre un aumento, aunque éste sélo se produce en el
instante final del llenado alcanzando los 2.5MPa.

Tensor de fibra

(15

Al igual que con una sola entrada, al
aumentar el porcentaje de fibra
aumenta también la probabilidad de
que esta se encuentre alineada en el

s

Ium

material.

brim e L

Figura Al.32. 3PP50 Orientacion de fibra
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e 3PA20

Tiempo de llenado

Figura Al.33. 3PA20 Llenado

Presion de inyeccion

Como con la primera configuracion, la poliamida
es un material mas viscoso por lo que tendra mas
resistencia al avance de material en el molde y
por lo tanto la presidn de inyeccion sera mayor.
En este caso esta presidn alcanza los 13MPa en
su valor maximo, que es en el punto de entrada
del material.

Figura Al.34. 3PA20 Presion de inyeccion

Temperatura en el frente de flujo

Izm

013

Como pasé con la configuracion de una Unica
entrada, la variacién de la temperatura en el
frente de flujo aumenta ligeramente debido a
la mayor viscosidad de la poliamida, hasta
alcanzar los 4°C.

Figura Al.35. 3PA20 Temperatura en el frente de flujo
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Fuerza de cierre
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Figura Al.36. 3PA20 Fuerza de cierre
Tensor de fibra
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Figura Al.37. 3PA20 Orientacidn de fibra

Trabajando con la poliamida vemos que es menos probable que la fibra se encuentre
alineada, teniendo un valor en torno a 0.6 por toda la pieza.
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e 3PA50

Tiempo de llenado

Figura Al.38. 3PA50 Llenado

Presion de inyeccion

La presion de inyeccion con la poliamida, al
igual que con el polipropileno, se ve
incrementada al aumentar el porcentaje de
fibra en el material. Este aumento es mas
notable en este caso ya que pasa de tener
13MPA con un 20% a los 22MPa con un 50%
en fibra.
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Figura Al.39. 3PA50 Presion de inyeccion

Temperatura en el frente de flujo @

Con la poliamida si que influye el aumento de
fibras en el material ya que la variacién de
temperatura es de 6°C. Aun asi esta dentro del
rango aconsejable para el proceso de inyeccién.

s
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Figura Al.40. 3PA50 Temperatura en el frente de flujo
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Fuerza de cierre
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Figura Al.41. 3PA50 Fuerza de cierre

La fuerza de cierre alcanza valores cercanos a los 3.5MPa, lo que se traduce en una
fuerza 1.5MPa mas alta que con un 20% en fibra.

Tensor de fibra

Fiber orentaton temon

A mayor porcentaje de fibra mejor
orientada se encuentra ésta. Con la
poliamida el cambio entre trabajar con
un 20% o con un 50% es mas notable
gue cuando se trabaja con el
polipropileno.

e

v

uropese
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Figura Al.42. 3PA50 Orientacion de fibra
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ANEXO Il. ABAQUS

ABAQUS es un programa destinado a resolver problemas de ciencias e ingenieria,
estando basado en el método de los elementos finitos. El programa puede resolver
casi todo tipo de problemas, desde un simple andlisis lineal hasta simulaciones
complejas no lineales. Ademads posee una extensa libreria de elementos finitos que
permite modelar virtualmente cualquier geometria, asi como su extensa lista de
modelos que simulan el comportamiento de una gran mayoria de materiales,
permitiendo su aplicabilidad en distintas areas de ingenieria.

El programa permite el diseiio de todo tipo de geometrias 2D y 3D para su posterior
estudio, pero en este trabajo, como ya se ha repetido anteriormente, la geometria
de la pieza estara ya disefiada, con lo que todas las caracteristicas de ABAQUS
relacionadas con el dibujo no seran utilizadas. Las caracteristicas que si que
utilizaremos seran las relativas al analisis estructural del componente, integrando
toda la informacion anteriormente obtenida en MOLDFLOW y DIGIMAT.

Los datos de entrada que se deben introducir son la geometria de la pieza, el
material del que esta fabricado y sus propiedades, las condiciones de contorno con
las que éste trabaja y las cargas que le son aplicadas.

Modulo Modulo
Material Ensamblaje
Modulo Archivo de Modulo
Elementos entrada Cargas
¥
Analisis

Figura All.1. Componentes de un modelo en ABAQUS

El andlisis estructural de ABAQUS nos dara como salida las tensiones y
deformaciones que sufre la pieza en cada uno de los ejes de coordenadas.

Procedimiento

Cuando abrimos ABAQUS, nos encontramos con una distribucion de elementos en
la pantalla donde podemos observar los componentes que se indican a continuacion,
y que se detallan en la Figura 1.1.
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e Barra de titulo: nos muestra la informacién referida al archivo en el que estamos
trabajando, la version de ABAQUS vy la ventana de trabajo que se encuentra
activa.

e Barra de Menu: se encuentran las distintas opciones de trabajo que tendremos
disponibles para cada mddulo, donde algunas se mantendran en comun (por
ejemplo, File, Model, Viewport, View y Edit) y otras variardn modulo a médulo.

e Barra de herramientas: las barras de herramientas brindan acceso rapido a
opciones que se encuentran contenidas dentro de los distintos menus.

e Caja de herramientas: encontraremos botones de acceso rapido a las distintas
herramientas disponibles para el médulo en el que se estd trabajando.

e Barra de contexto: nos permite navegar por los distintos mdédulos que posee
ABAQUS vy por las distintas funcionalidades de cada uno. Por ejemplo, en el
maodulo “Part”, nos permite navegar por los distintos modelos y las distintas
geometrias o partes.

e Arbol de modelo/resultados: organizan toda la informacién contenida en
nuestro modelo para permitirnos una vista y edicion rapida de la misma, como
también nos permiten navegar en distintos modelos. En la pestana “Model”
encontramos el diagrama de arbol referido al modelo en si, pudiendo trabajar
con mas de uno; mientras que en la pestana “Results” podemos trabajar con
distintos archivos de resultados de andlisis.

e Ventana de trabajo: es una ventana que nos muestra una determinada vista de
nuestro modelo. ABAQUS permite trabajar con distintas vistas de manera
simultanea.

e Area de mensajes y comandos: alli ABAQUS muestra los mensajes de estado,
advertencias y errores que se generan al ejecutar una determinada funcidn.

Barra de tivic R = & EF T R W . waW e |

o P E u Barr; de mend ol [ X
DSEwm ¢ «ifl B A [} J I EEEEE -
W raeaas - OOl E EE Coa 302z k.1 2 3 4 A

Model | fusuts || Motuie |- pat fr] Modet |- Model-l |+ Part | o —

|——mparra de herramientas

] Model Datfz] e o
= ﬂ Bodels (1) =
Model-1
B Parts
L§‘_; Materials
&} Calibrstians
i Sectivns
# Profiles
¥ ﬁ Azsembly
7o Staps (1)
B Field Dutput Reque &
!"1"-[ Histery Output Req
B Time Points
Bs ALE Adaptive Mesh
'ﬂ Irteractions
ﬁ Irteraction Properti
ﬂ Contack Controks
j& Cortact Intializatic
ﬂ] Constraints
E Connector Section:
--_'F Figlds
_nd Armiphitudes
[ Losds
L Bs
[ Predefined Fields
Blg Remeshing Rules
= ¥

Caja de herramientas

l—— Arbol de models/ resultados ,.)3 SIMULIA

Figura All.2. Pantalla principal de ABAQUS
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Una vez que se han visto todos los elementos de la pantalla del programa es hora de
comenzar con nuestro modelo. Para la generacién, cdlculo y visualizacién de resultados
de un modelo se deben seguir los siguientes pasos en el orden que se enumeran a
continuacion:

I. Generacidn de las partes del modelo

Il. Generacion de material.

. Definicidn y asignacion de las propiedades de la seccidn
IV. Ensamblaje del modelo

V. Definicion de los pasos de cdlculo del modelo

VI. Aplicacién de las cargas y las condiciones de contorno
VIIl. Mallado

VIII. Creacion y envio del calculo

IX. Visualizacién de resultado

Como se ha comentado en la memoria y en este mismo anexo, la geometria de la pieza
ya nos viene definida por archivo. El siguiente paso es el de definir el material de trabajo
en el apartado Materials, insertando algunas de sus propiedades mecanicas (mddulo de
Young, coeficiente de Poisson, viscosidad...) o térmicas. Se pueden definir tantos
materiales como se quiera, siempre y cuando se asignen correctamente a la zona

correspondiente.

- Model Database: C:\Temp'\practicab.cae [Viewport: 1]
Una vez definido el material es necesario crear la ..., Section  Pukle Compasie  fui

seccion y asignarla a la geometria. Para crear la Prf'zz" Manager. BAE
seccidn, ir al menu Section y seleccionar la opcion Creste... E
Create. ABAQUS abrira una ventana en la que
seleccionaremos la opcion Solid-Homogeneous, y
donde se da la opcién de identificar con un nombre
la seccién creada. A continuacion se abrira otra
ventana en la que debemos de asignar el material
que corresponde a esta seccidon creada.

ule: | Propert _ Part: | Par

B Assignment Manager...

i) Eij

Figura All.3. Creacion de una seccion

cticab.cae [Viewport: 1]

Composite | Assign  Special Feature Tools Plug-i

AT Tras crear la seccion, debemos asignarla a la
Beam Section Orientation - , . ’ .
Material Orientation L geometria creada. Para ello, ir al menu Assign y
Rebar Reference Orientation seleccionar la opcidon Section. ABAQUS pedira
N | . , .

Modekl [ o seleccionar la geometria correspondiente e

JTangent

inmediatamente abrird una ventana en la que
debemos de seleccionar la seccion correspondiente
del desplegable. Al asignar la seccidon veremos como

T la geometria cambia de color (verde).

Figura All.4. Asignar una seccion
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Una vez asignada la seccion, tenemos que crear el ensamblaje. Para ello seleccionar el
modulo Assembly del desplegable ubicado en la zona superior izquierda y seleccionar la
opcidon Create del menu Instance. ABAQUS desplegara una ventana con el Part
seleccionado y dos opciones para el tipo de Instance. Seleccione la opcidn Dependent
(mesh on part). La geometria cambiara nuevamente de color (azul) indicando que el
ensamblaje ha sido creado.

LR T an6.3-2 - Model Database: C\Temp'ipracticab.cae [ Ao &

[

B Mocule: | Aasemibly H Wlacdel: Mo Yiew | [nstance Cgnstreant  Featyre  Jools

s uf Pt f_TF I_ Create... 3 4 _j!‘

Fropanty Linear Pattern

- Raglial Pattern

ci _a | Sep

(1) e ey action Translate i
e

ferigs: 1) ez 0 Losd Translate To - i A
taons (1) L Whssh Kadul okute E - Model-1 i
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Py ¥ Visuahzatian - Eplace
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Dol rope C it
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Figura All.5. Ensamblaje de la pieza

Después procedemos a definir el Step. Para ello seleccionamos el mddulo Step del
desplegable localizado en la parte superior izquierda de la pantalla y marcamos en
Create. En la ventana abierta seleccionamos la opcién Linear Perturbation del
desplegable y verificamos que se encuentre seleccionada la opcidon Static-Linear
Perturbation.

Pasamos a definir las cargas y las condiciones de contorno. En el caso de las cargas
debemos cambiar al médulo Load para seleccionar la opcion Create del menu Load. Se
nos abrira una ventana en donde podremos elegir la categoria y el tipo de carga para
después asignarla a la parte de la pieza que deseemos e introducir su valor
correspondiente.

Para las condiciones de contorno iremos a BCs -> Create Boundary Condition y de la lista
de pasos de carga seleccionamos Initial. Posteriormente iremos a Category ->
Mechanical -> Types for Selected Step -> Symmetry-Antisymmetry-Encastre,
seleccionamos en la ventana principal del programa la zona de la pieza donde se
encuentra una de la condiciones y le decimos al programa de qué tipo se trata.
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Figuras All.6 y All.7. Creacion de las cargas (izquierda) y condiciones de contorno (derecha)

A continuacidn definimos el nimero de elementos en las diferentes lineas. En el menu
Seed, seleccionar la opcidn Edge by number. Seguidamente ABAQUS pide seleccionar las
regiones a las cuales asignar la semilla, las cuales cambiaran a color rojo, para después
introducir el nUmero de elementos deseados en las lineas.

Una vez especificado el numero de elementos en cada lado, especificamos el tipo de
malla a realizar. Esta malla, tal y como se ha dicho antes, no coincidira con la creada en
MOLDFLOW ya que ABAQUS no puede crear mallas con un nimero de elementos tan
elevado. Para ello, seleccionamos la opcidn Controls del menud Mesh. Y en la siguiente
ventana Quad en Element Shape, y Structured en la seccién Technique. Tras oprimir OK
vera como la geometria adquiere un color verde intenso.

El siguiente paso serd el de elegir el tipo de elemento para el analisis. Para ello
seleccionar la opciéon Mesh -> Elemet type y ABAQUS abrird una ventana en la con
diferentes caracteristicas a marcar como se puede ver en laimagen. Para mallar la Parte,
basta seleccionar la opcidon Mesh -> Part.
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Figura All.8. Caracteristicas del mallado

Para resolver el problema se crea un trabajo desde la opcidn Job del desplegable
localizado en la parte superior izquierda de la pantalla. Finalmente para ejecutar el
trabajo, seleccionar la opcion Job -> Submit y ABAQUS ejecutara el trabajo seleccionado.
Una vez concluida la ejecuciéon del modelo, para visualizar los resultados es necesario
cambiar al mddulo Visualization donde podemos ver resultados de tensiones y
desplazamientos.

Resultados

En esta seccidon se mostraran los resultados que ABAQUS no ofrece en cuanto a la
tension de Von Mises (derecha) y los desplazamientos sufridos en la pieza (izquierda).
En la Memoria se encuentran los valores numéricos de estos resultados por lo que aqui
Unicamente aparecerdn de modo grafico. Destacar que, tal y como se ha explicado en la
Memoria, la distribucion de estos resultados posee la misma forma para cada una de las
simulaciones realizadas.
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ANEXO Ill. DIGIMAT

DIGIMAT es un potente software que hace de unidn entre el proceso de fabricacién y
los datos obtenidos de la simulacidn estructural. Ofrece una serie de herramientas que
sirven para modelar con precision el comportamiento anisotropico no linear de
materiales compuestos y para predecir las mejoras estructurales que se dan al utilizar
estos materiales. Ademas, sirve de ayuda para el disefio y la fabricacién de nuevos
materiales compuestos y piezas con una mayor eficiencia y menor coste.

Results

Material

— 2

Solution

Figura Alll.1. Contenidos de DIGIMAT

Durante este trabajo, y tal y como se ha expuesto en la memoria, utilizaremos este
programa para integrar en la malla de ABAQUS toda la informacién recopilada del
proceso de fabricacidn que ha sido extraida mediante el software MOLDFLOW. Asi
seremos capaces de apreciar cémo afecta el proceso de inyeccién a las propiedades
mecanicas del componente, comparando estos resultados a los obtenidos sin aplicar la
metodologia de trabajo.

Procedimiento

Al abrir DIGIMAT lo primero que nos encontraremos sera una pantalla que nos pedira
elegir una de las diferentes modalidades de trabajo de las que se compone, tal y como
se ve en la imagen.
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Figura Alll.2. Pantalla de inicio

The multi-scale matenal medeling platform

SETTINGS

SERVICE
CENTER

Para la realizacién de nuestro trabajo entraremos en el médulo RP. Una vez dentro nos
aparecerd ya la pantalla de trabajo, con lo que nuestro siguiente paso serd ya el de
comenzar con la aplicacién de la metodologia, que sera llevada a cabo mediante una

serie de pasos bien sefalizados.

e b

Sy =g =
File ‘Workflow

O =
- S
Submit SOV Monitor Tile Auto Workspace

Table horzontally amange  snapshot
FE analyzec Window layout

Figura Alll.3. Barra de herramientas

Primero le damos a empezar un nuevo trabajo y el
programa nos pedird que introduzcamos la geometria
de nuestra pieza con todos los datos necesarios para
el andlisis mecanico del componente, como son las
cargas, condiciones de contorno o el material. Para
ello importamos el archivo .inp que hemos extraido de
ABAQUS y le indicamos los el sistema de unidades que
van a ser utilizados, que deberan coincidir con los que
hemos usado en ABAQUS. Seleccionamos Load Model,
elegimos nuestro archivo .inp que corresponda con el
caso que estamos estudiando y después le damos a

4 Material

PP-GF40

4 Microstructure (orientation)
@ From manufacturing process

1PP20b L4
From orientation file
*) From Digimat material
4 Field mapping
PP20.pp20.Mapped_Orientati.. &%

Figura Alll.4. Pasos a seguir para el andlisis

Add Digimat Material - Load Generic Data, donde deberemos seleccionar uno de los

30



materiales de referencia de los que dispone el programa para volcar en el toda la
informacién del material ya particularizado. Hay que seiialar que en DIGIMAT las
propiedades del material no se obtienen de igual forma que en otros programas, donde
se consiguen a partir de datos experimentales. DIGIMAT calcula las propiedades a partir
de las propiedades de la matriz y de la fibra por separado, en la proporcion adecuada
dependiendo del porcentaje de fibra que contenga.

Tras esto sera el momento de introducir la informacion correspondiente a MOLDFLOW.
Esta informacidn se encuentra alojada en dos archivos: en un archivo .pat donde esta la
malla de MOLDFLOW; y otro archivo .xml donde estan ubicados todos los datos sobre la
orientacién de fibra del material. Procedemos a introducir esta informacién
seleccionando Add Manufacturing Process para importar el .pat y tras esto Load Fields
para importar esta vez el .xml.

% Manufacturing process: 1PP20b

Load model... Load fields... Show model summary...

~ | Visualization options
[C] Show mesh
Fit view
Reset camera
Take snapshot
+X¥ +XZ +¥YZ

01
0,0366
5 A 4
A G 9
Z X

Figura Alll.5. Fibra en las diferentes direcciones

En la imagen podemos ver el proceso a seguir y como va tomando forma el andlisis de
nuestro componente. El programa muestra la orientacidon de fibra segun las direcciones
principales, es decir, segin 1, 2y 3.

El siguiente paso es el de realizar el mapeo a través de Map Requiered Fields 2 Map.
Nos aparecera una pantalla en la que nos pedira que introduzcamos la tolerancia que el
programa usard para el estudio. Introducimos la que nos aparece por defecto y, en caso
de que presente algun problema de célculo y éste no se lleve a cabo, posteriormente
seremos capaces de modificarla a nuestro antojo.

Ya solo nos quedara correr el programa para que realice el analisis mecanico. Para ello
seleccionamos Submit = Run Locally. Nos aparecera una pantalla donde nos da la
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posibilidad de modificar los archivos de datos del material y asi evitar la aparicién de
posibles errores de calculo. Una vez hechos los cambios deseados el programa
procederd al estudio del componente, a través de ABAQUS, el cual sera el propio
DIGIMAT el que se encargara de abrirlo, introducir toda la informacién y darnos los
resultados. DIGIMAT nos devolvera entonces una pantalla en la que indicara si el analisis
se ha realizado correctamente y nos abrird los resultados de éste en ABAQUS.

s FE analﬂwﬂi

Job name Software Status #CPUs Working directory Start time End time |
M| Pr20_DigimatCoupled| Abagus | Terminated| 1 | CAUsers\Feli\Documents\isaWfernandoi\tube\Tubo ABA| 7/13/2016 12:16:57 PM | 7/13/2016 1217:15 PM |
PP20_DigimatCoupled | Abaqus | Completed |1 | CAUsers\Felin\Documentslisa\femando\tubo\Tubo ABA| 7/13/2016 12:22:46 PM_| 7/13/2016 12:23:29 PM

Status:
Abaqus/Standard €.1L DATE -20. 23:2
SUMMARY OF
STEP NC X TOTAL TOTAL DOF IF
ITERS TIME/ TIME/LPF MONITOR RIES
FREQ
1 3 0 0.000 27e-016€ e-01€

f| = mmarvsis ms coprErEd svccEssroLny

Console output / log file:

0.Mapped_Orientacion.def. Number of
£ of elements = 31344 - Maximum nusber of

[ Dismias |

Figura Alll.6. Pantalla de andlisis

Resultados

Una vez visto el procedimiento de trabajo con el programa es hora de mostrar los
resultados obtenidos. Si bien es cierto que, al igual que con ABAQUS, las imagenes de
los resultados de las la distribucidn de la tensidn de Von Mises y de los desplazamientos
son iguales para todos los casos, se van a exponer estos resultados igualmente:
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Figura Alll.7. 1PP20
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Figura Alll.8. 1PP50
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Figura Alll.9. 1PA20
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Figura Alll.10. 1PA50

Figura Alll.11. 3PP20
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3PP50

Figura Alll.12. 3PP50

3PA20

Figura Alll.13. 3PA20
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ANEXO IV. ANALISIS DEL COMPONENTE AL QUE LE HA SIDO APLICADA LA
METODOLOGIA

La pieza que ha sido estudiada durante este trabajo es una parte del turbo del motor de
un automovil. En este apartado se explicara de una forma mdas especifica su
funcionamiento y los diferentes tipos que existen.

Historia

Los motores son maquinas muy ineficientes. Gran parte de la energia que se produce en
el interior de los motores procedente de la combustion del combustible se pierde por el
tubo de escape en forma de gases calientes. En el afilo 1905 un ingeniero suizo llamado
Alfred Biichi patentd el primer turbocompresor que utilizaba los gases de escape para
introducir aire de forma forzada en el motor.

Sin embargo no fue hasta varios afios mas tarde cuando el turbo se empezé a adoptar
de forma habitual en los aviones ya que al aumentar la altitud disminuia la presién y
densidad del aire, mermando la potencia de los motores, problema que solventaron
utilizando tanto compresores mecanicos como turbocompresores.

No fue hasta los afios 60 cuando el turbo vio aplicacién en el mundo del automovil, sin
embargo su consolidacidn se produjo con la llegada del primer coche de produccion con
motor turbodiesel, el Mercedes 300D. La turboalimentacidon encontré en los motores
diesel una relacion de simbiosis. Hasta entonces los motores diesel habian sido
mamotretos caros, pesados, ruidosos y poco potentes. El turbo consiguié mejorar
algunos de estos aspectos, lo que ayudod a su expansion por toda Europa, hasta el punto
de superar por mucho las ventas de los motores de gasolina.

Después de este éxito abrumador del diesel en Europa debido en gran parte a los turbos,
llegamos a la primera década del siglo XXI, en la que las normativas medioambientales
fuerzan cada vez mas a conseguir coches eficientes y limpios. Esto lleva a los fabricantes
de coches a mirar otra alternativa para seguir cumpliendo las normativas y vender
coches. El downsizing, motores de pequefio tamafio, muy apretados y eficientes que
encuentran en el turbo un aliado perfecto, ya sean de gasolina o diesel.

Gracias al turbo pueden dar potencias especificas imposibles de imaginar hasta hace
bien pocos afios en modelos de entrada a la gama con motores de gasolina, por encima
de los 100 CV por litro. Ademas el uso de turbocompresores aumenta la cantidad de par
disponible y lo ofrece en un rango mas amplio del régimen, por lo que esta relacién entre
los motores de gasolina y los turbos también es cdmoda de conducir en cruceros a
medias vueltas y encima consumiendo poco.
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Qué es y como funciona

La potencia que es capaz de generar un motor depende basicamente de la cantidad de
oxigeno que es capaz de hacer reaccionar con el combustible, por lo que cuanto mas
aire es capaz de “bombear” una mecdnica, mds fuerza tiene. Hay dos formas de
conseguir que en un motor entre mas aire: aumentando el volumen interno para que
guepa la mayor cantidad posible, o comprimir el aire para que sea capaz de entrar en
abundancia en una cilindrada pequefia. Esta Ultima alternativa es lo que se conoce como
“sobrealimentacion” vy se consigue comprimiendo el aire antes de meterlo en los
cilindros. Para ello se emplean diferentes dispositivos, siendo el mas utilizado el turbo.

El funcionamiento basico de un motor turbo es simple: se aprovechan los gases
generados por el motor para impulsar mas potencia y aumentar las revoluciones a la
qgue trabaja. El turbocompresor consiste en una turbina accionada por los gases de
escape del motor de explosidn, en cuyo eje se fija un compresor centrifugo que toma el
aire a presion atmosférica después de pasar por el filtro de aire y luego lo comprime
para introducirlo en los cilindros a mayor presion. Como el aire caliente tiene menos
densidad de oxigeno y ademads provocaria autodetonaciones, antes de mezclarlo con el
combustible y meterlo en los cilindros se enfria en un radiador que se llama intercooler.
Asi, al enviarse aire frio al motor con el turbo, ocupa menos espacio y entra mas
cantidad.

SECCION __
TURBINA
SECCION Y

COMPRESOR Whod F Salida de
W) s descarga
de gazes

Rueda de

la turbina

Entrada de de gazes

aire ambignte

al comprezor Descarga de aire

Rueda del compresor  de| compresar

Figura AIV.1. Funcionamiento del turbocompresor

Este aumento de la presion consigue introducir en el cilindro una mayor cantidad de
oxigeno que el que aspiraria a presion atmosférica, obteniéndose mas par motor en cada
carrera Util y por lo tanto mds potencia que un motor atmosférico de cilindrada
equivalente, y con un incremento de consumo proporcional al aumento de masa de aire
en el motor de gasolina. En los diésel la masa de aire no es proporcional al caudal de
combustible, siempre entra aire en exceso al ser por inyeccién el suministro de
combustible al cilindro, por ello es en este tipo de motores en donde se ha encontrado
su maxima aplicacion (motor turbodiésel)
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Constitucion de un turbocompresor

Los elementos principales que
forman un turbo son el eje comun (3)
gue tiene en sus extremos los rodetes
de la turbina (2) y el compresor (1)
este conjunto gira sobre los cojinetes
de apoyo, los cuales han de trabajar
en condiciones extremas y que
dependen necesariamente de un
circuito de engrase que los lubrica

Por otra parte el turbo sufre una
constante aceleracién a medida que
el motor sube de revoluciones y como
no hay limite alguno en el giro de la Figura AIV.2. Partes de un turbocompresor
turbina empujada por los gases de

escape, la presidon que alcanza el aire en el colector de admisidon sometido a la accion del
compresor puede ser tal que sea mas un inconveniente que una ventaja a la hora de
sobrealimentar el motor. Por lo tanto se hace necesario el uso de un elemento que nos
limite la presion en el colector de admisidn. Este elemento se llama valvula de descarga
o valvula waste gate (4).

Nosotros trabajaremos con la parte correspondiente a la zona por donde se escapan los
gases de salida del motor. Esta zona soporta fuerzas de presion interna, condicionada a
la cantidad de aire que sea expulsada. Esta carga posee un valor variable, siendo de
0.1MPa para un régimen nominal de funcionamiento.

Tipos de turbocompresores

Antiguamente habia dos tipos de turbos: aspirados y soplados. La diferencia basica era
en qué posicidn se intercalaban en el circuito del aire de admision. Los aspirados estaban
montados después de que el carburador hubiese realizado la mezcla de aire y
combustible, por lo que en realidad comprimian aire y gasolina al mismo tiempo. En los
soplados, el turbo comprime el aire antes de que se mezcle con el combustible. Como
actualmente todos los motores son de inyecciéon directa, todos los motores
sobrealimentados modernos son soplados, ya que el combustible no se afiade hasta que
el aire ya ha entrado en el cilindro.

Actualmente los turbos se diferencian entre turbos de geometria fija y de geometria
variable. En los primeros, el volumen de aire que entra en la turbina del lado del escape
es siempre el mismo. Esto tiene un inconveniente, y es que limitamos el rango éptimo
de funcionamiento del turbo. Si hacemos un turbo muy grande, necesita mucho gas de
escape para moverlo, pero a cambio nos entregara mucha presién de aire en la admisién
y mucho caudal. El inconveniente de este turbo seria que en la zona baja de revoluciones
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los gases no tienen energia suficiente como para accionarlo y, ademads, tendria mucha
inercia (desde que pisamos el pedal del acelerador hasta que generamos potencia hay
un tiempo muy largo, lo que se conoce como turbo-lag o retraso del turbo). Si por el
contrario contamos con un turbo pequefio, coge presidn rdpidamente aunque haya
pocos gases en el escape. Su ventaja es que seria capaz de comprimir aire con el motor
a pocas revoluciones y con un turbo-lag muy pequefio, pero no podria mantener la
presion en el colector de admision cuando el motor necesitase mucho caudal de aire.

Los turbos de geometria variable (VGT, variable geometry turbocharger) se inventaron
para intentar aunar las ventajas de un turbo pequefio y de uno grande. Para ello se
ponen unas aletas en el lado de la turbina que no gira (la caracola) que varian su posicién
y hacen mds grande o mas pequeiia la cavidad en la que se mueven los gases.

Segun sea el mecanismo que varia el volumen de la caracola de los turbos de geometria
variable tenemos:

e Turbos VGT neumadticos: un pulmon accionado por vacio tira de una varilla que
orienta las aletas.

e Turbos VGT eléctricos: un motor eléctrico acciona el mecanismo que orienta las
aletas. Son mas rapidos que los neumaticos y mas preciso pero son caros y
delicados.

Su funcionamiento es muy bueno, pero son caros y menos fiables que los de geometria
fija, de modo que poco a poco los fabricantes se decantan por el uso de dos turbos
colocados en serie, uno pequefio y uno grande, como veremos mads adelante.

Una forma de reducir el turbo lag es hacer mas pequefios los turbos. Esto se puede hacer
si reducimos la cantidad de aire que tienen que comprimir. Esto es lo que se conoceria
como un motor biturbo o twin turbo en paralelo (dos o mas turbos idénticos se reparten
el trabajo para parte de los cilindros del motor).

Materiales

Las altas temperaturas, propias de la tecnologia de la sobrealimentacion, y la progresiva
reduccion de tamano de los compartimientos del motor ponen sobre la mesa de los
ingenieros y disefiadores de piezas y sistemas, una serie de nuevos elementos a tener
en cuenta al seleccionar materiales. Al mismo tiempo, la tecnologia de Ia
sobrealimentacidn estd en continua evolucién, se le afaden nuevos subsistemas y se
dedican recursos para obtener el maximo rendimiento de todas las prestaciones y
beneficios ambientales del sistema en su conjunto.

La fabricacién de turbocompresores se reduce a materiales plasticos y materiales
metalicos. Es frecuente que en los coches de mas afios de antigliedad el turbo esté
fabricado integramente de metal, pero el avance de la industria automovilistica y el
progresivo requerimiento de vehiculos mas ligeros y por tanto mas eficientes, hacen que
cada vez sea mas usual el uso de compuestos plasticos. Para suplir a los metales en la
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fabricacion de estos componentes, los plasticos deben de cumplir los mismos
requerimientos mecdnicos que estos, y es por ello que son reforzados con fibras de otro
material. Estos materiales son los llamados materiales compuestos.

Durante este trabajo, y ya que se trata de un estudio actual, hemos seguido esta
tendencia y dos tipos de plasticos compuestos como son la poliamida y el polipropileno
han sido comparados, viendo y sacando las conclusiones adecuadas para ver cudl de
ambos es mejor para la fabricacion del turbo de un motor actual.
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